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QUESTION 1

You work as a Finance Manager for Blue Well Inc. The company has a Windows-based network. You are using Excel
spreadsheet for maintaining the financial budget and other financial calculations. You want to return the price per $100
face value of a security that pays interest at maturity. Which of the following financial functions will you use to
accomplish the task? 

A. PRICE function 

B. PPMT function 

C. PRICEMAT function 

D. PRICEDISC function 

Correct Answer: C 

Various financial functions (reference) are as follows: 

1.

 ACCRINT function: It is used to return the accrued interest for a security that pays periodic interest. 

2.

 ACCRINTM function: It is used to return the accrued interest for a security that pays interest at maturity. 

3.

 AMORDEGRC function: It is used to return the depreciation for each accounting period by using a depreciation
coefficient. 

4.

 COUPDAYBS function: It is used to return the number of days from the beginning of the coupon period to the
settlement date. 

5.

 AMORLINC function: It is used to return the depreciation for each accounting period. 

6.

 COUPDAYS function: It is used to return the number of days in the coupon period containing the settlement date. 

7.

 COUPDAYSNC function: It is used to return the number of days from the settlement date to the next coupon date. 

8.

 COUPNCD function: It is used to return the next coupon date after the settlement date. 

9.
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 COUPNUM function: It is used to return the number of coupons payable between the settlement date and maturity
date. 

10.

 COUPPCD function: It is used to return the previous coupon date before the settlement date. 

11.

 CUMIPMT function: It is used to return the cumulative interest paid between two periods. 

12.

 CUMPRINC function: It is used to return the cumulative principal paid on a loan between two periods. 

13.

 DB function: It is used to return the depreciation of an asset for a specified period by using the fixed-declining balance
method. 

14.

 DDB function: It is used to return the depreciation of an asset for a particular period by using the double-declining
balance method. 

15.

 DISC function: It is used to return the discount rate for a security. 

16.

 DOLLARDE function: It is used to convert a dollar price that is expressed as a fraction into a dollar price that is
expressed as a decimal number. 

17.

 DOLLARFR function: It is used to convert a dollar price that is expressed as a decimal number intoa dollar price that is
expressed as a fraction. 

18.

 DURATION function: It is used to return the annual duration of a security with periodic interest payments. 

19.

 EFFECT function: It is used to return the effective annual interest rate. 

20.

 FV function: It is used to return the future value of an investment. 

21.

 FVSCHEDULE function: It is used to return the future value of a starting principal after applying a series of compound
interest rates. 

22.
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 INTRATE function: It is used to return the interest rate for a fully invested security. 

23.

 IPMT function: It is used to return the interest payment for an investment for a specified period. 

24.

 IRR function: It is used to return the internal rate of return for a series of cash flows. 

25.

 ISPMT function: It is used to calculate the interest paid during a particular period of an investment. 

26.

 MDURATION function: It is used to return the Macauley modified duration for a security with an assumed par value of
$100. 

27.

 MIRR function: It is used to return the internal rate of return in which positive and negative cash flows are financed at
different rates. 

28.

 NOMINAL function: It is used to return the annual nominal interest rate. 

29.

 NPER function: It is used to return the number of periods for an investment. 

30.

 NPV function: It is used to return the net present value of an investment on the basis of a series of periodic cash flows
and a discount rate. 

31.

 ODDFPRICE function: It is used to return the price per $100 face value of a security with an odd first period. 

32.

 ODDFYIELD function: It is used to return the yield of a security with an odd first period. 

33.

 ODDLPRICE function: It is used to return the price per $100 face value of a security with an odd last period. 

34.

 ODDLYIELD function: It is used to return the yield of a security with an odd last period. 

35.

 PMT function: It is used to return the periodic payment for an annuity. 
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36.

 PPMT function: It is used to return the payment on the principal for an investment for a particular defined period. 

37.

 PRICE function: It is used to return the price per $100 face value of a security that pays periodic interest. 

38.

 PRICEDISC function: It is used to return the price per $100 face value of a discounted security. 

39.

 PRICEMAT function: It is used to return the price per $100 face value of a security that pays interest at maturity. 

40.

 PV function: It is used to return the current value of an investment. 

41.

 RATE function: It is use d to return the interest rate per period of an annuity. 

42.

 RECEIVED function: It is used to return the amount received at maturity for a fully invested security. 

43.

 SLN function: It is used to return the straight-line depreciation of an asset for one period. 

44.

 SYD function: It is used to return the sum-of-years\\' digits depreciation of an asset for a particular period. 

45.

 TBILLEQ function: It is used to return the bond-equivalent yield for a Treasury bill. 

46.

 TBILLPRICE function: It is used to return the price per $100 face value for a Treasury bill. 

47.

 TBILLYIELD function: It is used to return the yield for a Treasury bill. 

48.

 VDB function: It is used to return the depreciation of an asset for a specified or partial period by using a declining
balance method. 

49.

 XIRR function: It is used to return the internal rate of return for a schedule of cash flows that is not necessarily periodic. 
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50.

 XNPV function: It is used to return the net present value for a schedule of cash flows that is not necessarily periodic. 

51.

 YIELD function: It is used to return the yield on a security that pays periodic interest. 

52.

 YIELDDISC function: It is used to return the annual yield for a discounted security. 

53.

 YIELDMAT function: It is used to return the annual yield of a security that pays interest at maturity. 

 

QUESTION 2

You work as an Office Assistant for Blue well Inc. The company has a Windows-based network. You want to create a
VBA procedure for the open event of a workbook. You are at the step of adding the following lines of code to the
procedure: 

"Private Sub Workbook_Open() MsgBox Time Worksheets("Sheet2").Range("A2").Value = Time End Sub" 

Which of the following are the next steps that you will take to accomplish the task? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. Under Macro Settings in the Macro Settings category, click Enable all macros, and then click OK. 

B. Switch to Excel and save the workbook with the .xslm extension as a macro-enabled workbook and close it. 

C. Reopen the workbook. 

D. Click OK in the message box. 

Correct Answer: BCD 

 

 

QUESTION 3

You work as an Office Assistant for Dreams Unlimited Inc. You use Microsoft Excel 2013 for creating various types of
reports. You have created a report in the format given below: 
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In the A7 cell, you are required to put a formula so that it can fulfill the description provided in the B7 cell. 

Which of the following formulas will provide the required result? 

A. COUNTIF(B2:C5,"=Yes") 

B. COUNTIFS(B2:C5,"=Yes") 

C. COUNTIF(B2:B5,"=Yes",C2:C5,"=Yes") 

D. COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes") 

Correct Answer: D 

In order to get the required result, you will have to insert the following formula in the B7 cell: 

COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes") 

Only Sarah and David have exceeded their January and February quotas, therefore the formula will provide 2 as the
result. 

Answer option C is incorrect. The COUNTIF function of Excel does not support multiple criteria. 

Answer options A and B are incorrect. This formula will count all the cells that have the value 

"Yes" in the range B2:C5. As multiple criteria are not applied in the formula, it will provide 6 as the result. 

In order to get the required result, you will have to insert the following formula in the B7 cell: 

COUNTIFS(B2:B5,"=Yes",C2:C5,"=Yes") 

Only Sarah and David have exceeded their January and February quotas, therefore the formula will provide 2 as the
result. 

Answer option C is incorrect. The COUNTIF function of Excel does not support multiple criteria. 

Answer options A and B are incorrect. This formula will count all the cells that have the value 

"Yes" in the range B2:C5. As multiple criteria are not applied in the formula, it will provide 6 as the result. 

 

QUESTION 4
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You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You want to filter data
in a PivotTable report without opening drop-down lists to find the items that you want to filter. For this purpose, you are
using a slicer. After filtering the data, you want to delete the slicer. Which of the following steps can you take to
accomplish the task? 

Each correct answer represents a complete solution. Choose all that apply. 

A. Click the slicer that you want to delete on the Options tab in the Slicer type group. 

B. Click the Macro setting, and then delete the slicer from the Macro-enabled slicers list. 

C. Click the slicer, and then press Delete. 

D. Right-click the slicer, and then click Remove . 

Correct Answer: CD 

Take one of the following steps to delete a slicer: 

1.

 Right-click the slicer, and then click Remove . 

2.

 Click the slicer, and then press Delete. 

Answer options B and A are incorrect. These are invalid answer options. 

 

QUESTION 5

You work as an Office Assistant for Tech Perfect Inc. You are working in the spreadsheet of the 

company\\'s high selling products. You input a formula for calculating the monthly sell of a particular product but your
Excel cell shows a string of # symbols instead of returning a value as shown below: 

Which of the following are the reasons that are causing the above problem? Each correct answer represents a complete
solution. Choose all that apply. 

A. You are inserting a new column, next to a column that is already formatted as text. 

B. The cell is not wide enough for displaying the calculated value. 

C. The lookup_value or the array you are searching resides in a cell containing unseen spaces at the start or end of that
cell. 
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D. Excel is trying to show the contents of the cell as a date or time stored as positive numeric values within Excel, but
the cell contains a negative value. 

Correct Answer: BD 

The Cell Shows ##### error occurs because the cell is not wide enough for displaying the calculated value. The other
reason is that Excel is trying to show the contents of the cell as a date or time stored as positive numeric values within
Excel, but the cell contains a negative value. Answer option C is incorrect. The Failure to Look Up Values in Excel error
occurs when a user gets an unexpected error while trying to look up or match a lookup_value within an array and Excel
is not able to recognize the matching value. If the lookup_value or the array the user is searching resides in a cell, the
user can have unseen spaces at the start or end of that cell. This will create the situation where the contents of the two
cells that the user is comparing look the same but extra spaces in one of the cells cause the cells to have slightly
different content. The other reason is that the contents of the cells that are being compared may have different data
types. Answer option A is incorrect. The Excel Won\\'t Calculate My Function error occurs when a user types in a
function and presses Enter, the cell shows the function as the user typed it, instead of returning the function\\'s value.
The reason that causes this problem is that the cells containing the formula are formatted as \\'text\\' instead of the
\\'General\\' type. This happens when the user inserts a new column, next to a column that is already formatted as text
due to which the new column inherits the formatting of the adjacent column 

 

QUESTION 6

You work as a Project Manager for Blue Well Inc. The company has a Windows-based network. You want to rename a
worksheet as Important. 

Which of the following steps will you take to accomplish the task? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. Click the Insert tab and open the name sheet. 

B. Enter the name and click the OK button. 

C. Right-click on the Sheet tab and select the Rename option. 

D. Delete the old name, type the new name, and then click OK. 

Correct Answer: BC 

 

QUESTION 7

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You want to get the
trend of the Business data range. For this purpose, you want to use trendlines in the chart. Which of the following steps
will you take to apply the trendlines in the chart? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. Clear the check box of any Trendline fields to disconnect a slicer. 

B. Select the type that you want from Trendline options. 

C. Click the Insert Trendline arrow, and then click Trendline Connections on the Options tab in the Sort and Filter
group. 
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D. Select a chart and then navigate to the Chart Tools Layout tab. 

Correct Answer: BD 

 

QUESTION 8

You work as an Office Manager for Blue Well Inc. The company has a Windows-based network. You have two budget
situations in which one is the worst case and the other is the best case. You want to create both situations on the same
worksheet and then switch between them with the change in requirements. Which of the following will you use to
accomplish the task? 

A. Goal Seek 

B. Data table 

C. Scenario 

D. Solver add-in 

Correct Answer: C 

A scenario is defined as a type of what-if analysis tools. It is a set of values saved by Excel and can be substituted
automatically in cells on a worksheet. A user can create and save different groups of values on a worksheet and then
switch to any of these new scenarios to view different results. Scenario reports are not automatically recalculated. If the
user changes the values of a scenario, those changes will not be displayed in an existing summary report and he must
create a new summary report to show the reflection of the changed report. Answer option A is incorrect. Goal Seek is
defined as a type of what-if analysis tools. It is used if a user knows the result that he wants from a formula, but he is not
sure what input value the formula needs to get that result. It works with only one variable input value. Answer option D is
incorrect. The Solver add-in is used if a user knows the result that he wants from a formula, but he is not sure what input
value the formula needs to get that result. It is used for more than one input value. It works with a group of cells related
to the formula in the objective cell. Answer option B is incorrect. A data table is used to see all the outcomes in one
place. It is defined as a type of what-if analysis tools. It is used if a user has a formula that uses one or two variables or
multiple formulas that all use one common variable. It is used to examine a range of possibilities at a glance and since
the user focuses on only one or two variables, results are easy to read and share in tabular form. If automatic
recalculation is enabled, it is possible to recalculate the data in data tables immediately and as a result, the user always
gets fresh data. 

 

QUESTION 9

You work as an Office Assistant for Peach Tree Inc. Your responsibility includes creating sales incentive report of all
sales managers for every quarter. You are using Microsoft Excel to create a worksheet for preparing the report. You
have inserted the sales figures of all sales managers as shown in the image given below: 

You have to calculate the first quarter incentives for all sales managers. The incentive percentage (provided in cell B3)
is fixed for all sales managers. The incentive will be calculated on their total first quarter sales. You have to write a
formula in the cell F8. Then you will drag the cell border to the cell F12 to copy the formula to all the cells from F8 to
F12. In the first step, you select the F8 cell. Which of the following formulas will you insert to accomplish the task? 

A. =andBand3/100 * E8 

B. =B3/100 * E8 

C. =B3/100 * andEand8 
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D. =$B$3/100 * E8 

E. =B3/100 * $E$8 

Correct Answer: D 

In order to accomplish the task, you will have to insert the following formula: 

=$B$3/100 * E8 

According to the question, the formula will be inserted in cell F8 and then the cell\\'s border will be dragged to the F12
cell. Furthermore, the incentive percentage is fixed for all sales managers 

and the value is provided in the cell B3. You will have to insert a formula that refers to the B3 cell as an absolute
reference. For this you will have to type currency symbol ($) before the row 

name and column number. In order to accomplish the task, type the following formula in the cell F8: 

=$B$3/100 * E8 

When absolute reference is used for referencing a cell in a formula, dragging cell\\'s border to another cell does not
change the cell\\'s reference. Answer options B and E are incorrect. This formula references the B3 cell as a relative
reference. 

After inserting the formula, when the cell\\'s border is dragged, it will change the cell reference relatively. 

Answer options A and C are incorrect. Ampersand symbol (and) is not used for referencing cells in Excel. 

 

QUESTION 10

Rick works as an Office Assistant for Tech Perfect Inc. He is creating a user form through Microsoft Excel 2013. While
creating forms for a number of users, he is required to repeat some of the actions multiple times. It is a very time
consuming process. To resolve the issue, he has created a macro to record the sequence of actions to perform a
certain task. Now, he wants to run the macro to play those exact actions back in the same order. Which of the following
steps will Rick take to accomplish the task? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. Click on the \\'Macros\\' icon in the \\'Developer\\' tab under the \\'Code\\' category to run a Macro. 

B. The Macro will be run in any worksheet of the Workbook. 

C. Put the workbook in a trusted location. 

D. The Macro dialogue box appears on the screen which contains a list of Macros in it. Select the Macro to run and click
the Run button. 

E. Run the created Macro by using the shortcut key specified while creating the Macro. 

Correct Answer: ABDE 

Take the following steps to run a Macro: 

1.
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 Click on the \\'Macros\\' icon in the \\'Developer\\' tab under the \\'Code\\' category to run a Macro. 

2.

 The Macro dialogue box appears on the screen which contains a list of Macros in it. 

Select the 

Macro to run and click the Run button. 

3.

 The Macro will be run in any worksheet of the Workbook. 

4.

 A user can run the created Macro by using the shortcut key that he has specified while creating the Macro. The macro
records the user\\'s mouse clicks and keystrokes while he works and lets him play them back later. The macro can be
used to record the sequence of commands that the user uses to perform a certain task. When the user runs the macro,
it plays those exact commands back in the same order. Answer option C is incorrect. The benefit of connecting to
external data from Microsoft Excel is that a user can automatically update Excel workbooks from the real data source
whenever the data source is updated with new information. It is possible that the external data connection might be
disabled on the computer. For connecting to the data source whenever a workbook is opened, it is required to enable
data connections by using the Trust Center bar or by putting the workbook in a trusted location. 
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QUESTION 11

You work as an Office Assistant for Tech Tree Inc. You have created a report in a workbook in Microsoft Excel 2013.
You have a number of PivotTables in a single report. You want to apply the same filter to all of those PivotTables. For
this purpose, you are required to create a slicer in one PivotTable and share it with other PivotTables. Which of the
following steps will you take to accomplish the task? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. In the Insert Slicers dialog box, select the check box of the PivotTable fields for which you want to create a slicer. 

B. Click Insert Slicer in the Sort and Filter group on the Options tab. 

C. Hold down CTRL, and then click the items on which you want to filter. 

D. Select the Macro enabled checkbox of the PivotTable fields for which you want to create a slicer in the Insert Security
dialog box and then click OK. 

E. Click anywhere in the PivotTable report for which you want to create a slicer. 

Correct Answer: ABCE 

 

 

QUESTION 12

You work as a Sales Manager for Maini Industries. Your company manufactures and sells 

construction equipment. You have to create a report that will show the highest selling items of 

each month. The report will be in the following format: 

77-427 Practice Test | 77-427 Study Guide | 77-427 Braindumps                             13 / 18

https://www.certbus.com/77-427.html
https://www.certbus.com/77-427.html
https://www.certbus.com/77-427.html


https://www.certbus.com/77-427.html
2023 Latest certbus 77-427 PDF and VCE dumps Download

In a workbook, you create a table named Item_table as shown below: 

You fill in the required entries in the workbook. 

For the third column of the sheet, you want to use formulas to fill in the values. You want the 

cells in the third column to get automatically filled with the names corresponding to ItemID in the second column. You
want the exact values to be filled in the column. You select the C2 cell in the third column. 

Which of the following formulas will you enter in order to accomplish the task? 
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A. =VLOOKUP(B2,Item_table,2,FALSE) 

B. =VLOOKUP(B2,Item_table,2,TRUE) 

C. =VLOOKUP(2,Item_table,B2,FALSE) 

D. =VLOOKUP(2,Item_table,B2,TRUE) 

Correct Answer: A 

In order to accomplish the task, you will use the following formula: 

=VLOOKUP(B2,Item_table,2,FALSE) 

Answer option B is incorrect. According to the question, you want the exact values in the column. 

The TRUE value in the range_lookup argument provides the approximate match. Answer options C and D are incorrect.
The VLOOKUP functions used in the formulas have wrong syntaxes. 

 

QUESTION 13

You work as an Office Assistant for Tech Perfect Inc. You are working in the spreadsheet of the company\\'s high selling
products. You want to find out the matching values in the columns. While doing so, you get an unexpected error that
when you attempt to look up or match a lookup_value within an array; Excel is not able to recognize the matching value.
You want to store sets of values as text and convert sets of data to text by using Excel\\'s Text To Columns tool. Which
of the following steps will you take to accomplish the task? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. Select the Text to Columns option from the Data tab at the top of the Excel workbook. 

B. Select Text and click the Finish button in Column Data Formats. 

C. Select the Delimited option and click Next 

D. Make sure that all delimiter options are unselected, and then again click Next. 

E. Remove the unseen spaces at the start or end of the first Macro cell. 

F. Select the cells to convert their data to text. 

Correct Answer: ABCDF 

In this situation, you will take the following steps: 

1.

 Select the cells to convert their data to text. 

2.

 Select the Text to Columns option from the Data tab at the top of your Excel workbook. 

3.
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 Select the Delimited option and click Next. 

4.

 Make sure that all delimiter options are unselected, and then again click Next. 

5.

 Select Text and click the Finish button in Column Data Formats. 

 

QUESTION 14

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You want to make a
slicer available for use in another PivotTable. Which of the following steps will you take to accomplish the task? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. Click the Insert Slicer arrow, and then click Slicer Connections on the Options tab in the Sort and Filter group. 

B. In the Slicer Connections dialog box, clear the check box of any PivotTable fields for which you want to disconnect a
slicer. 

C. In the PivotTable Connections dialog box, select the check box of the PivotTables in which you want the slicer to be
available. 

D. Click the slicer that you want to share in another PivotTable. 

Correct Answer: CD 

 

 

QUESTION 15

You work as an Office Assistant for Tech Tree Inc. You have created a report in a workbook in Microsoft Excel 2013.
You have included various subtotals in a worksheet in the report to verify data accuracy. You want to remove all
subtotals from the sheet before you send it to your manager. 

Which of the following steps will you take to accomplish the task with the least administrative effort? 

A. Select all the subtotals. From the shortcut menu, click the Remove All Subtotals option. 

B. Hide the rows containing subtotals. 

C. Open the Subtotal dialog box by clicking the Subtotal option in the Outline group on the Data tab. Click the Remove
All button. 

D. Delete all the rows containing subtotals. 

Correct Answer: C 

According to the question, you have to remove all subtotals from the worksheet with the least administrative effort. You
can remove all subtotals from a worksheet at a time. For this, take the following steps: Open the Subtotal dialog box by
clicking the Subtotal option in the Outline group on the Data tab. 
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Click the Remove All option. 

Answer option A is incorrect. No such option is provided in Excel 2013. 

Answer option B is incorrect. Although this will hide the rows containing the subtotals, the contents will remain there and
can be made visible by using the Unhide row option. Moreover, the question specifically specifies to remove all
subtotals from the sheet. Answer option D is incorrect. Although this step will accomplish the task, it will involve a lot of
administrative burden of selecting each row and deleting it manually. 
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